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Preface

Oracle Identity Manager Connector Guide for PeopleSoft Employee Reconciliation provides 
information about integrating Oracle Identity Manager with PeopleSoft Employee 
Reconciliation.

Audience
This guide is intended for users who want to deploy the Oracle Identity Manager 
connector for PeopleSoft Employee Reconciliation.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at

http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites. 

Note: Some parts of the product and documentation still refer to the 
original Thor company name and Xellerate product name and will be 
rebranded in future releases.
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TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services 
within the United States of America 24 hours a day, seven days a week. For TTY 
support, call 800.446.2398.

Related Documents
For more information, refer to the following documents in the Oracle Identity Manager 
documentation set:

■ Oracle Identity Manager Release Notes

■ Oracle Identity Manager Installation and Upgrade Guide for JBoss

■ Oracle Identity Manager Installation and Upgrade Guide for WebLogic

■ Oracle Identity Manager Installation and Upgrade Guide for WebSphere

■ Oracle Identity Manager Administrative and User Console Guide

■ Oracle Identity Manager Administrative and User Console Customization Guide

■ Oracle Identity Manager Design Console Guide

■ Oracle Identity Manager Tools Reference Guide

■ Oracle Identity Manager Audit Report Developer Guide

■ Oracle Identity Manager Best Practices Guide

■ Oracle Identity Manager Connector Guide for BMC Remedy User Management

■ Oracle Identity Manager Connector Guide for CA-ACF2 Advanced

■ Oracle Identity Manager Connector Guide for CA-Top Secret Advanced

■ Oracle Identity Manager Connector Guide for Database Application Tables

■ Oracle Identity Manager Connector Guide for Database User Management

■ Oracle Identity Manager Connector Guide for IBM RACF

■ Oracle Identity Manager Connector Guide for IBM RACF Advanced

■ Oracle Identity Manager Connector Guide for IBM Lotus Notes and Domino

■ Oracle Identity Manager Connector Guide for Microsoft Active Directory

■ Oracle Identity Manager Password Synchronization Module for Microsoft Active 
Directory Installation and Configuration Guide

■ Oracle Identity Manager Connector Guide for Microsoft Exchange 2000 and 2003

■ Oracle Identity Manager Connector Guide for Microsoft Exchange 5.5

■ Oracle Identity Manager Connector Guide for Microsoft Windows 2000

■ Oracle Identity Manager Connector Guide for Microsoft Windows NT 4.0

■ Oracle Identity Manager Connector Guide for Novell eDirectory

■ Oracle Identity Manager Connector Guide for Novell GroupWise

■ Oracle Identity Manager Connector Guide for Oracle e-Business Employee Reconciliation

■ Oracle Identity Manager Connector Guide for Oracle e-Business User Management

■ Oracle Identity Manager Connector Guide for Oracle Internet Directory

■ Oracle Identity Manager Connector Guide for PeopleSoft Employee Reconciliation
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■ Oracle Identity Manager Connector Guide for PeopleSoft User Management

■ Oracle Identity Manager Connector Guide for Siebel Enterprise Applications

■ Oracle Identity Manager Connector Guide for RSA Authentication Manager

■ Oracle Identity Manager Connector Guide for RSA ClearTrust

■ Oracle Identity Manager Connector Guide for SAP CUA

■ Oracle Identity Manager Connector Guide for SAP Employee Reconciliation

■ Oracle Identity Manager Connector Guide for SAP Enterprise Portal

■ Oracle Identity Manager Connector Guide for SAP User Management

■ Oracle Identity Manager Connector Guide for Sun Java System Directory

■ Oracle Identity Manager Connector Guide for UNIX SSH

■ Oracle Identity Manager Connector Guide for UNIX Telnet

Documentation Updates
Oracle is committed to delivering the best and most recent information available. For 
information about updates to the Oracle Identity Manager 9.0.2 connector 
documentation set, visit Oracle Technology Network at

http://www.oracle.com/technology/documentation/index.html

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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What's New in the Oracle Identity Manager 
Connector for PeopleSoft Employee 

Reconciliation?

This chapter provides an overview of the updates made to the connector and 
documentation for PeopleSoft Employee Reconciliation in release 9.0.2 of the Oracle 
Identity Manager connector pack.

The updates discussed in this chapter are divided into the following categories:

■ Software Updates

These include updates made to the connector software.

■ Documentation-Specific Updates

These include major changes made to the connector documentation. These 
changes are not related to software updates.

Software Updates
This section discusses the following software updates implemented in this release of 
the connector.

Incorporation of Multilanguage Support
In addition to English, this release of the connector supports the French and Japanese 
languages. The following are documentation updates pertaining to the incorporation 
of this feature:

■ The installation media directory includes resource bundle files for the languages 
supported by the connector. These resource bundle files are described in the "Files 
and Directories That Comprise the Connector" section on page 1-2.

■ The "Step 2: Copying the Connector Files and External Code" section on page 2-2 
specifies the destination directory into which you must copy the resource bundle 
files during the deployment procedure.

■ The "Step 3: Configuring the Oracle Identity Manager Server" section on page 2-3 
describes the procedure to change to the required input locale and to clear content 
related to connector resource bundles from the server cache.

■ Chapter 4, "Known Issues" discusses two new issues related to the use of 
non-English locales.

See Also: Oracle Identity Manager Release Notes
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Determining the Release Number of the Connector
Instructions to determine the release number of the connector are given in the 
"Determining the Release Number of the Connector" section on page 1-4.

Changes in the List of Supported Target Systems
In the "Step 1: Verifying Deployment Requirements" section on page 2-1, the list of 
supported target systems has been expanded.

New Reconciliation Scheduled Task Attribute
The isDebug attribute has been added in the "Specifying Values for the Scheduled 
Task Attributes" section on page 2-18.

Other Additions to the Known Issues List
The following item has been added in the Known Issues list in Chapter 4:

You cannot deploy the connector files for both PeopleTools 8.22 and PeopleTools 8.4x 
on the same Oracle Identity Manager installation.

Documentation-Specific Updates
The following documentation-specific updates have been made in this release of the 
guide:

■ This release of the connector is certified for PeopleTools 8.10 through 8.22 and 
PeopleTools 8.40 through 8.46. Information and instructions pertaining to these 
releases of PeopleTools have been either added or reworded in this guide.

■ Oracle Identity Manager uses a PeopleSoft Employee Reconciliation user account 
to connect to and exchange data with PeopleSoft Employee Reconciliation. The 
"Step 1: Verifying Deployment Requirements" section on page 2-1 provides 
information about the minimum rights that must be assigned to this user account.

■ Instructions to copy the connector JAR files to all the nodes of a clustered 
environment have been added in the following sections:

–  Step 2: Copying the Connector Files and External Code section on page 2-2.

– Step 3: Configuring the Oracle Identity Manager Server on page 2-3

■ Instructions in the "Step 4: Configuring the Target System" section have been 
reworded.

■ In the "Step 5: Configuring the PeopleSoft Listener for Change-Based 
Reconciliation" section on page 2-14:

– Step 2 of the procedure has been removed. This step described the procedure 
to edit the attributemap.properties file.

– Step 9 has been broken down into three different steps.

Note: In this guide:

■ Each occurrence of "PeopleTools 8.22" refers to the entire range of 
PeopleTools releases from 8.10 through 8.22.

■ Each occurrence of "PeopleTools 8.4x" refers to the entire range of 
PeopleTools releases from 8.40 through 8.46.
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■ Instructions and pointers to information about configuring trusted source 
reconciliation have been moved to the "Configuring Trusted Source Reconciliation" 
section on page 2-17.

■ Step 8 of the procedure in the "Creating the Reconciliation Scheduled Tasks" 
section on page 2-18 has been reworded.

■ Instructions to use Oracle Identity Manager for linking multiple installations of 
PeopleSoft Employee Reconciliation are given in the "Configuring the Connector 
for Multiple Installations of the Target System" section on page 2-19.

■ Appendix A provides information about attribute mappings between Oracle 
Identity Manager and PeopleSoft Employee Reconciliation.



xii
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1
About the Connector

Oracle Identity Manager automates access rights management, security, and 
provisioning of IT resources. Oracle Identity Manager connectors are used to integrate 
Oracle Identity Manager with third-party applications. The connector for PeopleSoft 
Employee Reconciliation is used to integrate Oracle Identity Manager with PeopleSoft 
Employee Reconciliation.

This chapter contains the following sections:

■ Supported Functionality

■ Multilanguage Support

■ Employee Data Reconciliation

■ Files and Directories That Comprise the Connector

■ Determining the Release Number of the Connector

Supported Functionality
The following table lists the functions that are available with this connector.

Note: Oracle Identity Manager connectors were referred to as 
resource adapters prior to the acquisition of Thor Technologies by 
Oracle.

Function Type Description

Trusted Employee 
Reconciliation

Reconciliation Reconciles employee data from PeopleSoft 
Employee Reconciliation to Oracle Identity 
Manager. A corresponding user is created in 
Oracle Identity Manager. If the user already exists 
in Oracle Identity Manager, then this user is 
updated.

Nontrusted Employee 
Reconciliation

Reconciliation Reconciles employee data from PeopleSoft 
Employee Reconciliation to Oracle Identity 
Manager. A user is not created in Oracle Identity 
Manager.

See Also: Appendix A for information about attribute mappings 
between Oracle Identity Manager and PeopleSoft Employee 
Reconciliation.
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Multilanguage Support
In addition to English, this release of the connector supports the following languages:

■ French

■ Japanese

Employee Data Reconciliation
The connector supports employee data reconciliation in two ways:

■ Bulk reconciliation (first-time reconciliation)

This type of reconciliation is performed to reconcile records of existing employees 
using a flat file. The flat file is generated using an Application Engine program 
written in PeopleCode. This program is run using PeopleSoft Application 
Designer.

■ Change-based reconciliation

This type of reconciliation is performed using PeopleSoft Application Messaging 
Architecture. In change-based reconciliation, data for any newly created or 
updated employee is reconciled instantaneously.

Change-based reconciliation involves the use of:

– A PeopleCode trigger, which generates an XML message containing updated 
information

– Attribute definitions (usually resource parameters) to be synchronized

– A Web service that acts as a passive listener for XML messages from 
PeopleSoft

– An XML file, psft_xellerate_msg.xml, that defines the schema of the 
XML message received from PeopleSoft

The synchronization process from PeopleSoft Employee Reconciliation to Oracle 
Identity Manager involves the following steps:

1. Employee information is updated in PeopleSoft Employee Reconciliation. This 
activates a PeopleCode trigger.

2. The PeopleCode trigger generates an XML message containing the updated 
employee information and sends it to the listener for the PeopleSoft Employee 
Reconciliation connector.

3. The listener forwards the XML message to the PeopleSoft Employee 
Reconciliation connector using HTTP.

4. The PeopleSoft Employee Reconciliation connector receives the XML message 
and sends a reconciliation event to the Oracle Identity Manager.

Files and Directories That Comprise the Connector
The files and directories that comprise this connector are compressed in the following 
ZIP file on the installation media:

Enterprise Applications\PeopleSoft Enterprise Applications\PeopleSoft Employee 
Reconciliation Rev 3.2.0.zip

The following table lists the files and directories that comprise the connector.
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File in the Installation Media Directory Description

XML\adpPSFT_RECON_DM.xml This XML file contains definitions of the following components 
of the connector:

■ Resource object

■ Process definition

■ Process tasks

■ Custom Process Form

XML\adpPSFT_XellerateUser_RECON_DM.xml This XML file contains the configuration for the Xellerate User. 
You must import this file only if you plan to use the connector 
in trusted source reconciliation mode.

lib\xlPSFTHRRecon.jar This JAR file contains the class files that are used to implement 
bulk reconciliation.

lib\peopleSoftApp.war This WAR file contains the classes and configuration files 
required for the PeopleSoft listener Web application. This file is 
used to implement change-based reconciliation.

For PeopleTools 8.22:

PeopleCode\PT822\HRMSCBRecon.txt

For PeopleTools 8.4x:

PeopleCode\HRMSCBRecon.txt

This file contains the code that you must add to the 
PeopleCode for theSavePostChange event while performing 
the "Publishing the Message" procedure described in the 
"Creating and Publishing the Message" section on page 2-4.

For PeopleTools 8.22:

PeopleCode\PT822\HRMSBulkRecon.txt

For PeopleTools 8.4x:

PeopleCode\HRMSBulkRecon.txt

This file contains the code for the Application Engine program. 
It is used to generate the flat file for bulk reconciliation.

properties\configureReconciliation.prop
erties

This file is used to specify the date format used for 
reconciliation.

ThirdParty\csv.jar The csv.jar file is a third-party library that is used to read 
comma-separated files.

For PeopleTools 8.22, the following files in 
the MsgPublisher directory:

xliMsgPublisher.jar
publish.bat

The JAR file contains the class file that transfers the XML 
messages generated by the PeopleTools 8.22 file handler on the 
PeopleSoft Web server to the PeopleSoft connector listener 
servlet.

The publish.bat file is a Windows batch file that triggers the 
message transfer on a periodic basis. Refer to the "Configuring 
PeopleSoft Enterprise Portal" section on page 2-7 for more 
information.

test\psft-xel-test.vbs This VBScript file can be used to test the PeopleSoft listener 
Web service by creating XML messages similar to the ones 
created by PeopleSoft Employee Reconciliation.

test\psft_xellerate_msg.xml This XML file is used by the psft-xel-test.vbs file to 
define the schema of the XML message that is received from 
PeopleSoft Employee Reconciliation.

test\pingRequest.xml
test\pingResponse.xml
test\publishRequest.xml
test\publishResponse.xml

These XML files are required by the psft-xel-test.vbs file 
for communicating with the PeopleSoft listener Web service 
using XML over HTTP.
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The "Step 2: Copying the Connector Files and External Code" section on page 2-2 
provides instructions to copy these files into the required directories.

Determining the Release Number of the Connector
To determine the release number of the connector:

1. Extract the contents of the xlPSFTHRRecon.jar file. This file is in the lib 
directory inside the installation media directory.

2. Open the manifest.mf file in a text editor, which is one of the files bundled 
inside the xlPSFTHRRecon.jar file.

In the manifest.mf file, the release number of the connector is displayed as the 
value of the Version property.

For PeopleTools 8.22, the files in the 
resources\PT822 directory

For PeopleTools 8.4x, the files in the 
resources directory

Each of these files contains locale-specific information that is 
used by the connector.

Note: For PeopleTools 8.22, the resources\PT822 directory 
contains resource bundles only for the English locale. This 
issue is discussed in the Known Issues list in Chapter 4.

docs\B32166_01.pdf This guide, which provides instructions to deploy the 
connector.

Note: The files in the test directory are used only to run tests on the 
connector.

File in the Installation Media Directory Description
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2
Deploying the Connector

Deploying the connector involves the following steps:

■ Step 1: Verifying Deployment Requirements

■ Step 2: Copying the Connector Files and External Code

■ Step 3: Configuring the Oracle Identity Manager Server

■ Step 4: Configuring the Target System

■ Step 5: Configuring the PeopleSoft Listener for Change-Based Reconciliation

■ Step 6: Importing the Connector XML File

■ Step 7: Configuring Reconciliation

If you want to configure the connector for multiple installations of PeopleSoft 
Employee Reconciliation, then perform the following procedure:

■ Configuring the Connector for Multiple Installations of the Target System

Step 1: Verifying Deployment Requirements
To verify deployment requirements for the PeopleSoft Employee Reconciliation 
connector:

1. Ensure that your environment meets the requirements listed in the following table.

Item Requirement

Oracle Identity Manager Oracle Identity Manager release 8.5.3 or later

Target system The target system can be any one of the following:

■ PeopleSoft HRMS 8.3 SP 1

■ PeopleSoft HRMS 8.9

Ensure that the following components are installed 
and configured:

■ Tuxedo and Jolt (the application server)

■ PeopleSoft Internet Architecture

■ PeopleSoft Application Designer (2-tier mode)
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2. Ensure that you have administrative rights on the PeopleSoft Employee 
Reconciliation server to perform the following procedures: 

■ Create a new message node

■ Configure PeopleSoft Enterprise Portal

■ Add a routing rule to publish messages

Step 2: Copying the Connector Files and External Code
The files to be copied and the directories to which you must copy them are given in the 
following table.

External code The external code requirement consists of the 
following files:

■ HRMSBulkRecon.txt

■ HRMSCBRecon.txt

Refer to "Step 2: Copying the Connector Files and 
External Code" on page 2-2 for more information 
about these files.

Note: The directory paths given in the first column of this table 
correspond to the location of the connector files in the following ZIP 
file on the installation media:

Enterprise Applications\PeopleSoft Enterprise 
Applications\PeopleSoft Employee Reconciliation Rev 3.2.0.zip

Refer to the "Files and Directories That Comprise the Connector" 
section on page 1-2 for more information about these files.

File in the Installation Media Directory Destination Directory

Files in the XML directory OIM_home\xlclient

lib\peopleSoftApp.war OIM_home\xlclient\lib

lib\xlPSFTHRRecon.jar OIM_home\xellerate\ScheduleTask

lib\ThirdParty\csv.jar OIM_home\xellerate\ThirdParty

Files in the test directory OIM_home\xellerate\test

For PeopleTools 8.22, copy the files from the 
PeopleCode\PT822 directory

For PeopleTools 8.4x, copy the files from the 
PeopleCode directory

OIM_home\xellerate\Scripts

Note: You must copy the files for either 
PeopleTools 8.22 or PeopleTools 8.4x, not 
both. 

Item Requirement
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Step 3: Configuring the Oracle Identity Manager Server
Configuring the Oracle Identity Manager server involves the following procedures:

■ Changing to the Required Input Locale

■ Clearing Content Related to Connector Resource Bundles from the Server Cache

Changing to the Required Input Locale
Changing to the required input locale involves installing the required fonts and setting 
the required input locale.

To set the required input locale:

1. Open Control Panel.

2. Double-click Regional Options.

3. On the Input Locales tab of the Regional Options dialog box, add the input locale 
that you want to use and then switch to the input locale.

Clearing Content Related to Connector Resource Bundles from the Server Cache
Whenever you add a new resource bundle file in the 
OIM_home\xellerate\connectorResources directory or make a change in an 
existing resource bundle file, you must clear content related to connector resource 
bundles from the server cache.

For PeopleTools 8.22, copy the files from the 
resources\PT822 directory

For PeopleTools 8.4x, copy the files from the 
resources directory

OIM_home\xellerate\connectorResources

Note: You must copy the files for either 
PeopleTools 8.22 or PeopleTools 8.4x, not 
both. For PeopleTools 8.22, the 
resources\PT822 directory contains 
resource bundles only for the English 
locale. This issue is discussed in the 
Known Issues list in Chapter 4.

docs\B32166_01.pdf OIM_home\xellerate\docs\PeopleSoftEmp

Note: While installing Oracle Identity Manager in a clustered 
environment, you copy the contents of the installation directory to 
each node of the cluster. Similarly, you must copy the 
connectorResources directory and the JAR files to the 
corresponding directories on each node of the cluster.

Note: In a clustered environment, you must perform this step on 
each node of the cluster. Then, restart each node.

Note: Depending on the operating system used, you may need to 
perform this procedure differently.

File in the Installation Media Directory Destination Directory
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To clear content related to connector resource bundles from the server cache:

1. In a command window, change to the OIM_home\xellerate\bin directory.

2. Enter one of the following commands:

■ On Microsoft Windows:

PurgeCache.bat ConnectorResourceBundle

■ On UNIX:

PurgeCache.sh ConnectorResourceBundle

In this command, ConnectorResourceBundle is one of the content categories 
that you can remove from the server cache. Refer to the following file for 
information about the other content categories:

OIM_home\xellerate\config\xlConfig.xml

Step 4: Configuring the Target System
To configure the PeopleSoft Employee Reconciliation server, use an administrator 
account to perform the following procedures:

■ Creating and Publishing the Message

■ Configuring PeopleSoft Enterprise Portal

■ Preparing the Flat File for Bulk Reconciliation

Creating and Publishing the Message
The procedure to create and publish the message depends on the release of 
PeopleTools that you are using:

■ Creating and Publishing the Message on PeopleTools 8.22

■ Creating and Publishing the Message on PeopleTools 8.4x

Creating and Publishing the Message on PeopleTools 8.22
Creating and publishing the message on PeopleTools 8.22 involves the following steps:

1. To create the message channel:

a. Click Start, Programs, and Application Designer. The Application Designer 
window is displayed in the 2-tier mode.

b. Select New from the File menu. The New Definition dialog box is displayed.

c. Select Message Channel, and then click OK.

Note: You must perform Step 1 before you perform this step. If you 
run the command as follows, then an exception is thrown:

OIM_home\xellerate\bin\batch_file_name

Note: You can ignore the exception that is thrown when you perform 
Step 2.
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d. Save the new message channel as PERSON_BASIC.

e. Select Object Properties from the File menu. The Message Channel Properties 
dialog box is displayed.

f. Select the Run option, and then select Archive Messages.

g. Click OK and save the message.

2. To create the message:

a. In the Application Designer, select New from the File menu. The New 
Definition dialog box is displayed.

b. Select Message from the list, and then click OK.

c. Select Object Properties from the File menu. The Message Properties dialog 
box is displayed.

d. Click the Use tab.

e. On the Use tab, select the PERSON_BASIC message channel and the version 
of the message that you just created.

f. Select Active to make the message an active message, and then click OK.

g. Right-click VERSION_1, and select the Insert Child Record option. The Insert 
Record window is displayed.

h. Enter PERSONAL_DATA in the Name field, click Insert, and then click Close.

i. Click PERSONAL_DATA  under VERSION_1. All the fields comprising 
PERSONAL_DATA records are displayed.

By default, all the fields appear as selected. Deselect the fields that are not 
required for the message XML file to be generated. Refer to the 
OIM_home\xellerate\test\psft_xellerate_msg.xml file for 
information about the fields in the message XML file.

j. Repeat Steps g through i for the PS_PERS_NID, EMPLOYMENT, and JOB 
records.

k. Save the message as PSFT_XELLERATE_MSG.

3. To publish the message:

a. Select Open from the File menu. The Open Definition dialog box is displayed.

b. Select Component from the Definition list, enter PERSONAL_DATA in the 
Name Selection Criteria field, and then click Enter. All component names 
starting with the text PERSONAL_DATA are displayed.

c. Select PERSONAL_DATA from the list, and then click Open. The details of 
the PERSONAL_DATA component are displayed.

d. Click the Structure tab, right-click PERSONAL_DATA, and then select View 
PeopleCode. The PeopleCode for the PERSONAL_DATA component is 
displayed.

e. Select the SavePostChange event from the list in the upper-left corner of the 
window. The PeopleCode for this event is displayed.

f. Copy the code given in the following file immediately after the import 
definitions in the PeopleCode for the SavePostChange event:

OIM_home\xellerate\Scripts\HRMSCBRecon.txt
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g. Select Save from the File menu to save the changes to the PERSONAL_DATA 
component.

After you complete this procedure, proceed to the "Configuring PeopleSoft Enterprise 
Portal" section on page 2-7.

Creating and Publishing the Message on PeopleTools 8.4x
Creating and publishing the message on PeopleTools 8.4x involves the following steps:

1. To create the message channel:

a. Click Start, Programs, Peoplesoft8.9hcm, and then Application Designer. The 
Application Designer window is displayed in 2-tier mode.

b. Select New from the File menu. The New Definition dialog box is displayed.

c. Select Message Channel, and then click OK.

d. Save the new message channel as PERSON_BASIC. 

e. Select Definition Properties from the File menu. The Message Channel 
Properties dialog box is displayed.

f. Select the Run option, and then select Archive Messages.

g. Click OK and save the message.

2. After creating the message channel, create the message as follows:

a. In the PeopleSoft Application Designer, select New from the File menu. The 
New Definition dialog box is displayed.

b. Select Message from the list and then click OK.

c. Select Definition Properties from the File menu. The Message Properties 
dialog box is displayed.

d. Click the Use tab.

e. On the Use tab, select the PERSON_BASIC message channel and the version of 
the message that you create in Step 2 of this procedure. 

f. Select Active to make the message an active message.

g. Save the message as PSFT_XELLERATE_MSG.

3. To publish the message:

a. Select Open from the File menu. The Open Definition dialog box is displayed.

b. Select Component from the Definition list, enter PERSONAL_DATA in the 
Name Selection Criteria field, and then press Enter. All component names 
starting with the text PERSONAL_DATA are displayed. 

Note: The reconciliation process requires the Application Engine 
program to be run in 2-tier mode. To open the Application Designer in 
2-tier mode, you must have the database client, which is the client of 
the database that PeopleSoft is using, installed on the server. In 
addition, you must select the appropriate database type from the 
Connection Type field (for example, Oracle Database) while 
providing sign-on information in the PeopleSoft Application Designer 
Signon window.
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c. Select PERSONAL_DATA from the list, and then click Open. The details of the 
PERSONAL_DATA component are displayed.

d. Click the Structure tab, right-click PERSONAL_DATA, and then select View 
PeopleCode. The PeopleCode for the PERSONAL_DATA component is 
displayed.

e. Select the SavePostChange event from the list in the upper-right corner of the 
window. The PeopleCode for this event is displayed.

f. Copy the code given in the following file after the import definitions in the 
PeopleCode for the SavePostChange event:

OIM_home\xellerate\Scripts\HRMSCBRecon.txt

g. Add the following function call code at the end of the PeopleCode for the 
SavePostChange event:

/**********************************************************************/
/*  Calling the Generate function to generate the 
PSFT_XELLERATE_MSG message*/
/**********************************************************************/
Local string &emplid;
&emplid = PERSON.EMPLID;
GENERATE(&emplid);

h. To save the changes to the PERSONAL_DATA component, select Save from the 
File menu.

Configuring PeopleSoft Enterprise Portal
PeopleSoft Enterprise Portal provides a single gateway to critical information in 
PeopleSoft Employee Reconciliation and other PeopleSoft applications.

The procedure to configure PeopleSoft Enterprise Portal depends on the release of 
PeopleTools that you are using:

■ Configuring PeopleSoft Enterprise Portal on PeopleTools 8.22

■ Configuring PeopleSoft Enterprise Portal on PeopleTools 8.4x

Configuring PeopleSoft Enterprise Portal on PeopleTools 8.22
Configuring PeopleSoft Enterprise Portal on PeopleTools 8.22 involves the following 
steps:

1. To create the XL_NODE remote node:

a. In the Application Designer, select New from the File menu. The New 
Definition dialog box is displayed.

b. Select Message Node from the list, and then click OK.

c. Right-click anywhere in the white space, and then select Insert Location. The 
Location dialog box is displayed.

d. Enter the URL for the PeopleSoft Application Gateway in the following 
format:

Note: Perform this step after you copy the code from the 
HRMSCBRecon.txt file. 
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http://hostname:port/servlets/gateway

e. Select Object Properties from the File menu. The Message Node Properties 
dialog box is displayed.

f. Select the Use tab. Ensure that Local Node is not selected.

g. Save the remote node as XL_NODE.

2. To configure the PERSON_BASIC message channel:

a. From the File menu, select Open and then click Message Channel.

b. To open the PERSON_BASIC message channel, select PERSON_BASIC.

c. Click the Routing Rules tab.

d. Right-click anywhere in the empty area of the right pane, and then select 
Insert Message Node. The Insert Message Node dialog box is displayed.

e. Select the XL_NODE message node, and then click Insert.

f. Click Cancel to close the dialog box.

g. Right-click the message node displayed on the Routing Rules tab. 

h. Point to Routing Direction, and then select Publish To.

i. Save the message channel.

3. To configure the PeopleSoft Enterprise Portal gateway so that messages can be 
sent through the gateway to third-party systems:

a. In a Web browser, use a URL with the following format to launch the 
PeopleSoft configuration servlet interface (handler directory):

http://hostname:port/servlets/gateway.administration

In this URL, hostname is the application server that hosts PeopleSoft and 
port is the port number at which the application server is listening.

b. Click Add Handler. The Add Handler window is displayed.

c. Enter the full name of the Simple File Handler class, 
psft.pt8.filehandler.SimpleFileHandler.

d. Click Save. The Handler Directory window is displayed.

e. To load the handler, click Load. After the handler loads, the "Loaded 
successfully" message is displayed in the Status column.

f. Click Configure.

g. Click Add a file handler node. The Add File Handler Node window is 
displayed.

h. In the Node Name field, enter the name of the message node that you create, 
XL_NODE.

i. Specify the output directory in which the published messages are to be stored.

j. Select Include Header.

Note: The Simple File Handler is a utility in PeopleTools 8.22 that 
can receive messages published by a PeopleSoft node and write these 
messages to a file that can be used by third-party systems.
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k. Click Save.

4. XML messages are generated by the PeopleTools 8.22 Simple File Handler. To 
publish these messages to the PeopleSoft Connector Listener servlet, you must 
create a scheduled task as follows:

a. Copy the publish.bat and xliMsgPublisher.jar files from the 
OIM_home\xellerate\MsgPublisher directory to a directory on the  
PeopleSoft Employee Reconciliation server.

b. Use a text editor to open the publish.bat file, and then make the following 
changes in the file:

i. Change the value of the JAVA_HOME variable so that it points to the JDK 
installation directory on the PeopleSoft Web server.

ii.  Specify the following values in the Java command given at the end of the 
file:

- PeopleSoft_listener_servlet_URL

- Output_directory_for_XML_messages

- XML_message_name

- console_log_file_path

The command is in the following format:

java com.thortech.xl.Integration.msgpublisher.PeopleSoftPublisher 
"PeopleSoft_listener_servlet_URL" "Output_directory_for_XML_messages" 
XML_message_name >> console_log_file_path

For example:

java Com.thortech.xl.Integration.msgpublisher.PeopleSoftPublisher 
"http://host:port/peopleSoftApp/do/peopleSoftAction" "C:/test/file" 
PSFT_XELLERATE_MSG >> c:/test/consolelog.log

c. Save and close the batch file.

d. On the PeopleSoft Web server, click Start, Settings, and Control Open.

e. Double-click Scheduled Tasks.

f. Click Add Schedule Task, and then click Next.

g. Click Browse, and then select the publish.bat file from the directory in 
which you save it.

h. Select Daily, click Next, and then click Next again.

i. Enter the user ID and password for the scheduled task to run.

Note: The scheduled task calls a Java program that communicates 
with the servlet deployed on the Oracle Identity Manager server. The 
servlet parses the message and sends reconciliation events to Oracle 
Identity Manager.

The servlet then sends a return code based on the status of 
reconciliation event. If the reconciliation event is successfully sent, 
then the message is deleted or archived. Otherwise, the message file is 
left unchanged. The next time the scheduled task is run, another 
attempt is made at sending the message.
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j. Select the Open Advance properties check box.

k. Click Finish.

l. On the Schedule tab, click Advanced.

m. Select Repeat Task.

n. Select the frequency at which you want the task to run.

o. Click OK, and then click OK again to close the window.

Configuring PeopleSoft Enterprise Portal on PeopleTools 8.4x
Configuring PeopleSoft Enterprise Portal on PeopleTools 8.4x  involves the following 
steps:

To configure the PeopleSoft Enterprise Portal gateway so that messages can be sent 
through the gateway to the connector:

1. Open a Web browser and enter the URL for PeopleSoft Enterprise Portal. The URL 
for PeopleSoft Enterprise Portal is in the following format:

http://servername/psp/Databasename/?cmd=login

For example:

http://psftserver.acme.com/TestDB/?cmd=login

2. Expand PeopleTools, Integration Broker, and then Gateways. The Gateway 
component details are displayed.

3. Enter LOCAL in the Integration Gateway ID field, and then click Search. The 
LOCAL gateway is a default gateway that is created when you install PeopleSoft 
Enterprise Portal.

4. Ensure that the IP address specified in the URL of the PeopleSoft listening 
connector is the IP address of the Web server on which PeopleSoft Employee 
Reconciliation is installed. The PeopleSoft listening connector is a  module 
provided by PeopleSoft. The URL of the PeopleSoft listening connector is in the 
following format:

http://computer_name/PSIGW/PeopleSoftListeningConnector

For example:

http://172.19.151.53/PSIGW/PeopleSoftListeningConnector

5. Click Load Gateway Connectors to load all target connectors that are registered 
with the LOCAL gateway.

6. Click Save.

To create the XL_NODE node to serve as the remote node:

1. In the PeopleSoft Enterprise Portal window, expand PeopleTools, Integration 
Broker, and Node Definitions.

2. Click the Add a New Value tab.

3. On the Add a New Value tab, enter XL_NODE as the node name and then click 
Add. The Node Definition page is displayed.

4. Enter a description for the node in the Description field.
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5. Make this node a remote node by deselecting the Local Node check box and 
selecting the Active Node check box.

6. On the Connectors tab, enter the following information and then perform a 
lookup:

Gateway ID: LOCAL

Connector ID: PSFT81TARGET

7. On the Properties tab, enter the following information:

Property ID: PSFT81TARGET

Property Name: URL

Required value: Enter the URL of the PeopleSoft servlet that is supposed to receive 
the XML message. This URL must be in the following format:

http://computer_name:port/peopleSoftApp/do/peopleSoftAction

For example:

http://myserver:8080/peopleSoftApp/do/peopleSoftAction

8. Click Save.

9. On the Transactions tab, click Add Transaction. The Add Transaction dialog box is 
displayed.

10. Enter the following details to define a new transaction:

Transaction Type: Outbound Asynchronous

Request Message: PSFT_XELLERATE_MSG

Request Message Version: VERSION_1

11. Click Add.

12. To keep the status as active, select Active.

13. Click Save to save the changes.

To secure the PERSON_BASIC message channel:

1. In PeopleSoft Enterprise Portal, expand PeopleTools, Security, Permission & 
Roles, and Permission Lists.

2. Select AEAE1000. The AEAE1000 permission list is displayed.

3. Select the Message Monitor tab, and then click the '+' button to add a channel 
name.

4. Specify PERSON_BASIC as the channel name, and select FULL as the access 
level.

5. Click Save.

6. To verify that the PERSON_BASIC message channel is in running mode:

a. Expand PeopleTools, Integration Broker, Monitor, and Monitor Message.

b. Click the Channel Status tab.

c. Verify that the PERSON_BASIC message channel is running. If it is paused, 
then click Run.
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Preparing the Flat File for Bulk Reconciliation
Preparing the flat file for bulk reconciliation involves the following steps:

■ Creating the Application Engine Program

■ Running the Application Engine Program

Creating the Application Engine Program
The bulk reconciliation process requires creating the Application Engine program. To 
create this program:

1. Click Start, Programs, Peoplesoft8.9hcm, and then Application Designer. The 
Application Designer window is opened in 2-tier mode.

2. Select New from the File menu. The New Definition dialog box is displayed.

3. Select Application Engine from the Definition list. The App Engine Program 
window is displayed.

4. Click the plus sign (+) that is displayed before the MAIN section in the Application 
Engine Program under which there may be multiple steps and in each step there 
may be some PeopleCode to be run. By default, a step titled Step01 is created and 
added to MAIN.

5. Rename Step01 to Populate.

6. In the App Engine Program window, select Action from the Insert menu. An 
action is added to the Populate step.

7. Select PeopleCode from the list for the new action. 

8. Click Save from the File menu to save the Application Engine program with the 
name BLKPRCS_HR.

9. Double-click the PeopleCode action. A new PeopleCode window is displayed.

10. In the PeopleCode window, copy the code from the   
OIM_home\xellerate\Scripts\HRMSBulkRecon.txt file. A sample 
directory path for the output file is given in this code. Change the sample directory 
path to a directory path on the PeopleSoft Employee Reconciliation server.

11. Save the Application Engine program and close the window.

Running the Application Engine Program
The procedure to run the Application Engine program depends on the release of 
PeopleTools that you are using:

■ Running the Application Engine Program on PeopleTools 8.22

■ Running the Application Engine Program on PeopleTools 8.4x

Running the Application Engine Program on PeopleTools 8.22
To run the Application Engine program on PeopleTools 8.22:

1. Log in to the PeopleSoft Enterprise Portal.

2. Click People Tools, Process Scheduler Manager, Use, and Process Definitions. 
The Process Definitions page is displayed.

3. Click Add a New value.

4. Select Application Engine from the Process Type list.
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5. Enter the name of the Application Engine program as the process name, for 
example, BLKPRCS_HR. 

6. Click Add. 

7. Select the Application Engine Program from the search results  that are displayed 
when you click Add.

8. On the Process Definition Options tab, specify the following values:

■ Run Location: Server

■ Server Name: PSNT

■ Component: PRCSMULTI

■ Process Groups: ALLPANLS

9. Click Save.

10. Return to the home page.

11. Click People Tools, Process Scheduler Manager, Process, and Sample Processes. 
The Sample Processes page is displayed.

12. Click Add a New value.

13. Specify a run control ID, and then click Add.

14. Click Run. The Process Scheduler Request page is displayed

15. Specify the server name.

16. Select the Application Engine program name, and then click OK.

17. Click Process Monitor to verify the status of the process.

After the process status changes to Success, the comma-separated file is created 
at the location specified in the code that you copy from the HRMSBulkRecon.txt 
file.

Running the Application Engine Program on PeopleTools 8.4x

To run the Application Engine program on PeopleTools 8.4x:

1. Click Start, Programs, Peoplesoft8.9hcm, and then Application Designer. The 
Application Designer window is opened in 2-tier mode.

2. Specify the connection type, user ID, and password.

3. To open the Application Engine program that you create:

Note: A run control ID is used as a key for records that contain the 
parameters required by a process at run time. If the parameters are 
stored in a table that the process can query using the run control ID 
and user ID, then the process can run without user intervention.

Note: For the Application Engine program to run in 2-tier mode, the 
database client must be installed on the server used for accessing the 
application designer. To switch to the 2-tier mode, you select 
Connection Type as the database on the PeopleSoft sign-on screen. 
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a. From the File menu, select Open and then select Application Engine Program 
from the Object Type list.

b. Select BLKPRCS_HR, and then click Open.

4. Click the RUN PROGRAM control on the toolbar below the menu bar. The code 
for the PeopleCode action is run. The comma-separated file containing employee 
records is created at the location specified in the code.

Step 5: Configuring the PeopleSoft Listener for Change-Based 
Reconciliation

This section describes how to configure the listener for the connector. In the following 
instructions, OIM_home refers to the local Oracle Identity Manager Server installation 
directory.

To configure the PeopleSoft listener:

1. Enter the following command to extract the contents of the peopleSoftApp.war 
file. This file is in the OIM_home\xlclient\lib directory.

jar –xvf peopleSoftApp.war

2. Edit the deployment.properties file. This file contains the message property, 
which corresponds to the name of the XML message from the PeopleSoft feed. The 
default value of this attribute is PSFT_XELLERATE_MSG. Obtain the correct value 
for this attribute from the PeopleSoft administrator.

3. Edit the xlsession.properties file. This file contains the following Oracle 
Identity Manager connection parameters:

■ ObjectName: This is the name of the resource object in Oracle Identity 
Manager against which the reconciliation event is created. The default value is 
PSFT_HR_RO. However, for nontrusted reconciliation, you can change it to 
the name of any other resource object.

■ Username: This is the user name for logging in to Oracle Identity Manager. 
The default value is xelsysadm.

■ Password: This is the password for logging in to Oracle Identity Manager. You 
must enter the encrypted value for the default password:

Kk3821YZhIoG36lvDH2YTw==

4. Edit the xlclient.properties file. This file contains the following system 
properties that enable an API client to communicate with Oracle Identity Manager:

■ xl.homedir: This property specifies the Oracle Identity Manager client 
directory. Typically, the Oracle Identity Manager client directory is 
OIM_home\xlclient.

Note: All the files mentioned in the remaining steps of this 
procedure are extracted from the peopleSoftApp.war file.

Note: If the password for Oracle Identity Manager is different from 
the default password, then refer to Appendix B for information about 
encrypting a plaintext password.
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■ java.security.policy: This property specifies the path of the security policy file. 
Typically, this file is located in the OIM_home\xlclient\config directory.

■ java.security.auth.login.config: This property specifies the path of the 
authentication configuration file. Typically, this file is located in the 
OIM_home\xlclient\config directory.

Each application server uses a different authentication configuration file:

IBM WebSphere: authws.conf

BEA WebLogic: authwl.conf

JBoss Application Server: auth.conf

■ java.naming.provider.url: This property specifies the JNP URL of the 
application server. This URL is given in the 
<Discovery><CoreServer><java.naming.provider.url> tag of the  
OIM_home\xlclient\config\xlconfig.xml file.

5. Edit the following properties in the configureReconciliation.properties 
file:

■ reconciliationMode: This property can accept one of two possible values:

– If you want to perform reconciliation in trusted mode, then set this 
property to trusted.

– If you want to perform reconciliation in nontrusted mode, then set this 
property to nontrusted.

■ Serverdateformat: This property specifies the date format that is used by the 
PeopleSoft Employee Reconciliation server. You can select one of the following 
date formats:

– dd-mmm-yy

– ddmmyy

– yyddmm

– yymmdd

■ xellerateOrganization: This property contains the name of the Oracle Identity 
Manager organization. The default value of this property is Xellerate 
Users. The value that you assign to this property must exist in Oracle 
Identity Manager.

■ nullDate: This property contains the default value for a date field. The value is 
2200/01/01 00:00:00 PST. This value is used if the date field is left 
empty.

■ PeoplesoftstartingYEAR:  The year is specified in two digits. If the number 
represented by these two digits (xx):

– Is greater than or equal to 50, then it is assumed that the year is 19xx.

– Is less than 50, then it is assumed that the year is 20xx.

 This specifies a range of 1950 to 2049 for the year.

■ XelServerDate: This property contains the date format that is used for the 
Oracle Identity Manager server.

Current value of the XelServerDate property: yyyy/MM/dd hh:mm:ss z 
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6. Copy the following files from the OIM_home\xellerate\lib directory to the 
WEB-INF\lib directory:

■ wlXLSecurityProviders.jar

■ xlAPI.jar

■ xlAuthentication.jar

■ xlBackOfficeBeans.jar

■ xlBackofficeClient.jar

■ xlCache.jar

■ xlCrypto.jar

■ xlDataObjectBeans.jar

■ xlDataObjects.jar

■ xlLogger.jar

■ xlUtils.jar

■ xlVO.jar

Copy the following files from the OIM_home\xellerate\ext directory to the 
WEB-INF\lib directory:

■ oscache.jar

■ javagroups-all.jar

7. Delete the peopleSoftApp.war file from the temporary directory in which you 
extract it, and then use the following command to re-create the file:

jar –cvf peopleSoftApp.war .

8. Ensure that the old version of the peopleSoftApp.war file is removed from the 
application server (JBoss, IBM WebSphere, or BEA WebLogic) deployment 
directory and the OIM_home\xellerate\webapp directory.

9. Copy the newly created peopleSoftApp.war file into the application server 
(JBoss, IBM WebSphere, or BEA WebLogic) deployment directory and the 
OIM_home\xellerate\webapp directory.

10. Restart the Oracle Identity Manager server and client.

Step 6: Importing the Connector XML File
To import the connector XML file into Oracle Identity Manager:

1. Open the Oracle Identity Manager Administrative and User Console.

2. Click the Deployment Management link on the left navigation bar.

3. Click the Import link under Deployment Management.  A dialog box for locating 
files is displayed.

Note: You can add custom attributes to be reconciled during 
change-based reconciliation. However, you must complete the 
deployment procedure before you can add custom attributes.

Refer to Appendix C for information about the procedure to add 
custom attributes for reconciliation.
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4. Locate and open the adpPSFT_RECON_DM.xml file, which is in the 
OIM_home\xlclient directory. Details of the XML file are shown on the File 
Review page.

5. Click Add File. The Substitutions page is displayed.

6. Click Next. The Confirmation window is displayed.

7. Click View Selections.

The contents of the XML file are displayed on the Import page. You may see a 
cross-shaped icon along with some nodes. Remove these nodes by right-clicking 
each node and then selecting Remove.

8. Click Import. The connector file is imported into Oracle Identity Manager.

Step 7: Configuring Reconciliation
Configuring reconciliation involves the following steps:

■ Configuring Trusted Source Reconciliation

■ Creating the Reconciliation Scheduled Tasks

Configuring Trusted Source Reconciliation

To configure trusted source reconciliation, you must first import the XML file for 
trusted source reconciliation as follows:

1. Open the Oracle Identity Manager Administrative and User Console.

2. Click the Deployment Management link on the left navigation bar.

3. Click the Import link under Deployment Management. A dialog box for locating 
files is displayed.

4. Locate and open the adpPSFT_XellerateUser_RECON_DM.xml file, which is in 
the OIM_home\xlclient directory. Details of this XML file are shown on the File 
Preview page.

5. Click Add File. The Substitutions page is displayed.

6. Click Next. The Confirmation page is displayed.

7. Click Import. 

8. In the message that is displayed, click Import to confirm that you want to import 
the XML file and then click OK.

Then, set the value of the IsTrusted reconciliation scheduled task attribute to YES  
while performing the procedure described in the following section.

Note: Perform this step of the procedure only if you want to 
configure trusted source reconciliation. Only one connector can be 
configured for trusted source reconciliation. If you import the 
adpPSFT_XellerateUser_RECON_DM.xml file while you have 
another trusted source configured, then both connector reconciliations 
would stop working.

Refer to Oracle Identity Manager Connector Framework Guide for 
conceptual information about reconciliation configurations.
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Creating the Reconciliation Scheduled Tasks
To create the scheduled tasks for lookup fields and user reconciliations:

1. Open the Oracle Identity Manager Design Console.

2. Expand the Xellerate Administration folder.

3. Select Task Scheduler.

4. Click Find. The details of the predefined scheduled tasks are displayed.

5. Enter a number in the Max Retries field. This number represents the number of 
times Oracle Identity Manager must attempt to complete the task before assigning 
the ERROR status to the task.

6. Ensure that the Disabled and Stop Execution check boxes are not selected.

7. In the Start region, double-click the Start Time field. From the date-time editor 
that is displayed, select the date and time at which you want the task to run.

8. To set the task to run only once, select the Once option in the Interval region.

9. Provide values for the attributes of the scheduled task. Refer to the "Specifying 
Values for the Scheduled Task Attributes" section on page 2-18 for information 
about the values to be specified.

10. Click Save. The scheduled task is created. The INACTIVE status is displayed in 
the Status field, because the task is not currently running. The task is run at the 
date and time that you set in Step 7.

11. Repeat Steps 5 through 10 to create the second scheduled task.

After you create the scheduled task, proceed to the "Configuring the Connector for 
Multiple Installations of the Target System" section on page 2-19.

Specifying Values for the Scheduled Task Attributes
You must specify values for the following attributes of the employee reconciliation 
scheduled task.

Note: Attribute values are predefined in the connector XML file that 
you import. Specify values only for those attributes that you want to 
change.

Attribute Name Description Sample Value

FolderPath Directory path where 
employee reconciliation files 
generated by PeopleSoft 
Employee Reconciliation are 
stored

C:\PSFTHR\UserRecon

TargetSystem Name of the resource object PSFT_HR_RO

IsTrusted Specifies whether or not 
reconciliation is to be 
performed in trusted mode

YES or NO

The default value is NO.
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After you specify values for these task attributes, go to Step 10 of the procedure to 
create scheduled tasks.

Configuring the Connector for Multiple Installations of the Target System

To configure the connector for multiple installations of the target system:

1. Create and configure one resource object for each target system installation.

The Resource Objects form is in the Resource Management folder. The 
PSFT_HR_RO resource object is created when you import the connector XML file. 
You can use this resource object as the template for creating the remaining 
resource objects.

2. Design one process form for each resource object.

The Form Designer form is in the Development Tools folder. The UD_PSFT_HR 
process form is created when you import the connector XML file.

You can use this process form as a template for creating the remaining process 
forms.

3. Create and configure one process definition for each resource object.

The Process Definition form is in the Process Management folder. The PSFT_HR 
Process process definition is created when you import the connector XML file. 
You can use this process definition as the template for creating the remaining 
process definitions.

While creating process definitions for each target system installation, the following 
steps that you must perform are specific to the creation of each process definition:

■ From the Object Name lookup field, select the resource object that you create 
in Step 1.

■ From the Table Name lookup field, select the process form that you create in 
Step 3.

XellerateOrganization Default name for the Oracle 
Identity Manager 
organization

This value is used to create 
the Xellerate User in trusted 
mode.

Xellerate Users

DateFormatFolderPath Directory path where the 
configureReconciliatio
n.properties file is stored

C:\PSFTHR\DateFormat\c
onfigureReconciliation
.properties

isDebug Debug feature YES or NO

The default value is NO.

Note: Perform this procedure only if you want to configure the 
connector for multiple installations of PeopleSoft Employee 
Reconciliation. Refer to Oracle Identity Manager Design Console Guide 
for detailed instructions on performing each step of this procedure.

Attribute Name Description Sample Value
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4. Configure reconciliation for each target system installation. Refer to the "Step 7: 
Configuring Reconciliation" section on page 2-17 for instructions. Note that only 
the values of the following attributes are to be changed for each reconciliation 
scheduled task:

■ TargetSystem

■ IsTrusted

Set the IsTrusted attribute to YES for the PeopleSoft Employee Reconciliation 
installation that you want to designate as a trusted source. You can designate 
either a single or multiple installations of PeopleSoft Employee Reconciliation as 
the trusted source. For the remaining PeopleSoft Employee Reconciliation 
installations, set this attribute to NO.

5. If required, modify the fields to be reconciled for the Xellerate User resource 
object.

Additional Steps for Configuring Change-Based Reconciliation
For change-based reconciliation, you must perform the procedure described in the 
"Step 4: Configuring the Target System" section on page 2-4 and in the "Step 5: 
Configuring the PeopleSoft Listener for Change-Based Reconciliation" section on 
page 2-14.

The following are actions that you must perform differently from the procedure 
described in these sections:

■ In Step 4.b of the "Configuring PeopleSoft Enterprise Portal on PeopleTools 8.22" 
section on page 2-7:

Cange the Java command in the publish.bat file as shown in the following 
example:

java Com.thortech.xl.Integration.msgpublisher.PeopleSoftPublisher 
"http://host:port/peopleSoftApp1/do/peopleSoftAction" "C:/test/file" 
PSFT_XELLERATE_MSG >> c:/test/consolelog.log

Similarly, change the name of the Web application for each WAR file that you 
create.

■ In Step 7 of the procedure to create the XL_NODE node, given in the "Configuring 
PeopleSoft Enterprise Portal on PeopleTools 8.4x" section on page 2-10:

Change the name of the application in the URL as shown in the following 
example:

http://computer_name:port/peopleSoftApp1/do/peopleSoftAction

Similarly, change the name of the Web application in the URL for each WAR file 
that you create.

■ In the "Step 5: Configuring the PeopleSoft Listener for Change-Based 
Reconciliation" section on page 2-14:

Note: Perform this step only if you use PeopleTools 8.22.

Note: Perform this step only if you use PeopleTools 8.4x.
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In Step 3, the value that you specify for the ObjectName parameter in the 
xlsession.properties file must be the name of the resource object that you 
create.

In Step 7, specify a different file name in the command that you use to re-create the 
WAR file. For example:

jar –cvf peopleSoftApp1.war

Similarly, change the name of the WAR file for each target system installation.
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3
Testing the Connector

Testing the connector involves verifying that the PeopleSoft Listener Web application 
can reconcile employees into Oracle Identity Manager. This chapter provides 
instructions to perform this test.

Prerequisites for Testing the PeopleSoft Listener Web Application
The following are prerequisites for testing the PeopleSoft Listener Web application:

■ Ensure that the Microsoft Windows scripting engine is installed. This is required to 
run VBScript files.

■ Ensure that the PeopleSoft XML message schema is described in the 
psft_xellerate_msg.xml file, which is in the OIM_home\xellerate\test 
directory.

Testing the PeopleSoft Listener Web Application
To test the PeopleSoft Listener Web application:

1. In the OIM_home\xellerate\test\psft-xel-test.vbs file:

■ Modify the value of the ps_server_url variable so that it points to the URL 
for the PeopleSoft Listener Web application.

■ Specify the required PeopleSoft attributes and employee data values in the 
ExecuteATM function.

2. Run psft-xel-test.vbs. Ensure that the script runs without any errors.

When the script is run, it creates a reconciliation event. Verify that the reconciliation 
event is created in Oracle Identity Manager and that the event contains the data that 
you specify in the VBScript file.
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4
Known Issues

The following are known issues associated with this release of the connector:

■ Secure Socket Layer (SSL) connections are not supported.

■ The connector files for PeopleTools 8.22 and PeopleTools 8.4x cannot be deployed 
on the same Oracle Identity Manager installation.

■ The version of the connector for PeopleTools 8.22 is not localized for the French 
and Japanese languages. For this version, the connector-related fields in Oracle 
Identity Manager can be displayed only in English.
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A
Attribute Mappings Between Oracle Identity 

Manager and PeopleSoft Employee 
Reconciliation

The following table discusses attribute mappings between Oracle Identity Manager 
and PeopleSoft Employee Reconciliation.

Oracle Identity Manager 
Attribute

PeopleSoft Employee 
Reconciliation Attribute Description

EmployeeID PS_NAMES.EMPLID Person ID associated with user

LastName PS_NAMES.LAST_NAME Last name

FirstName PS_NAMES.FIRST_NAME First Name

Sex PS_PERSONAL_DATA.SEX Sex

Postal PS_PERSONAL_DATA.POSTAL Postal address

City PS_PERSONAL_DATA.CITY City name

SSN PS_PERS_NID.NATIONAL_ID National ID provided to user

Phone PS_PERSONAL_DATA.PHONE Telephone number

BirthDate PS_PERSONAL_DATA.BIRTHD
ATE

Date of birth

Country PS_PERSONAL_DATA.COUNT
RY

Country name

Address PS_PERSONAL_DATA.ADDRE
SS1

Contact address

State PS_PERSONAL_DATA.STATE State

HireDate PS_EMPLOYMENT.HIRE_DT Date of hire

DepartmentID PSJOB.DEPTID Department ID

JobCode PSJOB.JOBCODE Job code
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B
Encrypting a New Oracle Identity Manager 

Password

If the password of the Oracle Identity Manager administrator is different from the 
default password, then you must encrypt the Oracle Identity Manager password as 
follows:

1. On the Oracle Identity Manager server, open a command window.

2. In the command window, change to the OIM_home\xellerate\ScheduleTask 
directory.

3. Enter the following command:

java -classpath xlPSFTHRRecon.jar  \
com.thortech.xl.Integration.peoplesoft.util.tcUtilEncryption -e \
OIM_plaintext_password

In this command, OIM_plaintext_password is the new Oracle Identity 
Manager administrator password that you want to encrypt.

The encrypted password is displayed in the command window.

4. Copy the encrypted password into the xlsession.properties file. This file is 
compressed in the OIM_home\xlclient\lib\peopleSoftApp.war file.

5. Delete the peopleSoftApp.war file from the temporary directory in which you 
extract it, and then use the following command to re-create the file:

jar –cvf peopleSoftApp.war .

6. Ensure that the old version of the peopleSoftApp.war file is removed from the 
application server (JBoss Application Server, IBM WebSphere, or BEA WebLogic) 
deployment directory and the OIM_home\xellerate\webapp directory.

7. Copy the newly created peopleSoftApp.war file into the application server 
(JBoss, IBM WebSphere, or BEA WebLogic) deployment directory and the 
OIM_home\xellerate\webapp directory.

8. Restart the Oracle Identity Manager server and client.

Note: The default administrator user ID is xelsysadm.
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C
Adding Custom Attributes for Reconciliation

Standard change-based reconciliation involves the reconciliation of predefined 
attributes. If required, you can add custom attributes to the list of attributes that are 
reconciled.

The procedure to add a custom attribute for reconciliation depends on the release of 
PeopleTools that you are using:

■ Adding a Custom Attribute for Reconciliation on PeopleTools 8.22

■ Adding a Custom Attribute for Reconciliation on PeopleTools 8.4x

Adding a Custom Attribute for Reconciliation on PeopleTools 8.22
To add a custom attribute for reconciliation on PeopleTools 8.22:

1. In PeopleSoft Application Designer:

a. Select Open from the File menu. The Open Definition dialog box is displayed.

b. Select Message from the Definition list, enter PSFT_XELLERATE_MSG in the 
Name Selection Criteria field, and then click Enter. The details of the 
PSFT_XELLERATE_MSG message are displayed.

c. Click the record to which you want to add custom attributes.

For example, suppose you want to add the job location attribute, LOCATION, 
then click JOB under VERSION_1.

d. Select the check box for the required attribute, and then save the message.

For example, select the LOCATION check box.

2. Make the required changes in the PeopleCode given in the HRMSCBRecon.txt 
file. This file is in the OIM_home\xellerate\Scripts directory. The required 
changes are as follows:

a. At the end of the SQL statements section, edit the SQL statement to retrieve 
the column values for the new attribute and store the values in local variables.

For example, suppose you want to add the job location attribute, LOCATION, 
to the list of attributes that are reconciled. Then, performing this step involves 
editing the SQL statement as follows, so that it retrieves the values of the 
LOCATION column from the JOB table:

Note: Before you can add custom attributes, you must complete the 
connector deployment procedure described in Chapter 2.
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SQLExec("select DEPTID, JOBCODE, LOCATION from ps_job a where emplid =:1 
and effdt=(select max(effdt) from ps_job b where a.emplid=b.emplid and 
effseq =(select max(effseq) from ps_job c where b.emplid = c.emplid and 
b.effdt=c.effdt))", &empid, &deptid, &jobcd, &location);

b. Add the required lines at the end of the block of code for adding data to the 
XML message. For example, to add the LOCATION column to the JOB tag, add 
the lines highlighted in bold in the following code sample:

/* FOR JOB RECORD */
&MSG_ROWSET.GetRow(1).JOB.JOBCODE.Value = &jobcd;
&MSG_ROWSET.GetRow(1).JOB.DEPTID.Value = &deptid;
&MSG_ROWSET.GetRow(1).JOB.LOCATION.Value = &location;

3. To extract the contents of the peopleSoftApp.war file into a temporary 
directory, enter the following command:

jar –xvf peopleSoftApp.war

Copies of this file are in the application server deployment directory and the 
OIM_home\xellerate\webapp directory.

4. In the attributemap.properties file, add the XPath (key-value entry) of the 
custom attribute. For example, you can add the following XPath for the LOCATION 
attribute:

PSFTHR.Location=//Transaction/DEPT_TBL/LOCATION

5. Delete the existing peopleSoftApp.war file from the temporary directory into 
which you extract it, and then enter the following command to re-create the file:

jar –cvf peopleSoftApp.war .

6. Delete the old version of the peopleSoftApp.war file from the application 
server deployment directory and the OIM_home\xellerate\webapp directory.

7. Copy the newly created peopleSoftApp.war file into the application server 
deployment directory and the OIM_home\xellerate\webapp directory.

8. In the Oracle Identity Manager Design Console, make the required changes as 
follows:

a. Add a column corresponding to the new attribute in the User Defined process 
form, UD_PSFT_HR. For the example described earlier, you can add the 
UD_PSFT_HR_LOCATION column.

b. Add a reconciliation field corresponding to the new attribute in the resource 
object, PSFT_HR_RO. For the example described earlier, you can add the 
PSFTHR.Location reconciliation field.

c. Modify the PSFT_HR Process process definition to include the mapping 
between the newly added attribute and the corresponding reconciliation field. 
For the example described earlier, the mapping is as follows:

PSFTHR.Location = UD_PSFT_HR_LOCATION

9. Restart the Oracle Identity Manager server and client.

See: Oracle Identity Manager Design Console for detailed instructions 
on performing the following steps
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Adding a Custom Attribute for Reconciliation on PeopleTools 8.4x
To add a custom attribute for reconciliation on PeopleTools 8.4x:

1. Make the required changes in the PeopleCode given in the HRMSCBRecon.txt 
file. This file is in the OIM_home\xellerate\Scripts directory. The required 
changes are as follows:

a. At the end of the SQL statements section, add a SQL statement to retrieve the 
column values for the new attribute and store the values in local variables.

For example, suppose you want to add the department location attribute, 
LOCATION, to the list of attributes that are reconciled. Then, performing this 
step involves adding the following SQL statement to retrieve the values of the 
LOCATION column from the PS_DEPT_TBL table:

SQLExec("SELECT DESCR, LOCATION FROM PS_DEPT_TBL WHERE DEPTID=:1", &deptid, 
&deptname, &location);

b. Add the required lines at the end of the block of code for adding data to the 
XML message. For example, to add the LOCATION column to the DEPT_TBL 
tag, add the lines highlighted in bold in the following code sample:

&recnode = &fieldtypenode.AddElement("DEPT_TBL");
&recnode.AddAttribute("class", "R");
&fields = &recnode.AddElement("DEPTNAME");
&fields.AddAttribute("type", "CHAR");
&fields = &recnode.AddElement("LOCATION");
&fields.AddAttribute("type", "CHAR");

c. Add the required lines at the end of the block of code for adding data to the 
XML message. For example, to add the LOCATION column to the DEPT_TBL 
tag, add the lines highlighted in bold in the following code sample:

&datarecnode = &transnode.AddElement("DEPT_TBL");
&datarecnode.AddAttribute("class", "R");
&datafldnode = &datarecnode.AddElement("DEPTNAME");
&textnode = &datafldnode.AddText(&deptname);
&datafldnode = &datarecnode.AddElement("LOCATION");
&textnode = &datafldnode.AddText(&location);

2. In PeopleSoft Application Designer, copy the contents of the HRMSCBRecon.txt 
file into the savePostChange event for the PERSONAL_DATA component.

3. To extract the contents of the peopleSoftApp.war file into a temporary 
directory, enter the following command:

jar –xvf peopleSoftApp.war

Copies of this file are in the application server deployment directory and the 
OIM_home\xellerate\webapp directory.

4. In the attributemap.properties file, add the XPath (key-value entry) of the 
custom attribute. For example, you can add the following XPath for the LOCATION 
attribute:

PSFTHR.Location=//Transaction/DEPT_TBL/LOCATION

5. Delete the existing peopleSoftApp.war file from the temporary directory into 
which you extract it, and then enter the following command to re-create the file:

jar –cvf peopleSoftApp.war .
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6. Delete the old version of the peopleSoftApp.war file from the application 
server deployment directory and the OIM_home\xellerate\webapp directory.

7. Copy the newly created peopleSoftApp.war file into the application server 
deployment directory and the OIM_home\xellerate\webapp directory.

8. In the Oracle Identity Manager Design Console, make the required changes as 
follows:

a. Add a column corresponding to the new attribute in the User Defined process 
form, UD_PSFT_HR. For the example described earlier, you can add the 
UD_PSFT_HR_LOCATION column.

b. Add a reconciliation field corresponding to the new attribute in the resource 
object, PSFT_HR_RO. For the example described earlier, you can add the 
PSFTHR.Location reconciliation field.

c. Modify the PSFT_HR Process process definition to include the mapping 
between the newly added attribute and the corresponding reconciliation field. 
For the example described earlier, the mapping is as follows:

PSFTHR.Location = UD_PSFT_HR_LOCATION

9. Restart the Oracle Identity Manager server and client.

See: Oracle Identity Manager Design Console for detailed instructions 
on performing the following steps
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